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1

Precondition:

1. Admin User.

2. User Group#1 having Group Type#1 with the Group Membership as below:

    1. Excluded: Added User#1 to the Excluded Users section of User Group#1

    2. Manually Added: Added User#2 to the Add Users Directly section of User Group#1

    3. Meets Criteria: Added User#3 via Edit Group Criteria section of User Group#1

    4. Suggested Excluded: Added User#4 to the Suggested Excluded Users section of User 

Group#1

    5. Suggested Manually Added: Added User#5 to the Suggested Add Users Directly section of 

User Group#1

    6.  Suggested Meets Criteria: Added User#6 via Suggested Edit Group Criteria section of User 

Group#1

2

Login as Admin User mentioned in the Precondition; Access User Profile; Click on 

Administrative View button.

Click on Search for User Group#1 mentioned in the Precondition; Click on Quick Reports link in 

the left navigation pane; 

Verify new Quick Report "User Group Membership" with Description "Report allowing you to 

view direct, inherited and excluded members of the selected user group. Note: this report will 

not include suggested group membership." is displayed under "Membership Reports" Quick 

Report Type.

Admin User will be navigated to General Information screen of User Group#1.

New Quick Report "User Group Membership" with Description "Report allowing you to view direct, inherited 

and excluded members of the selected user group. Note: this report will not include suggested group 

membership." will be  displayed under "Membership Reports" Quick Report Type.

3

Click on Run Icon for User Group Membership Quick Report Verify Admin User is navigated to 

the generated User Group Membership Quick Report with the below details are displayed in 

the User Group Membership  Report:

Report Name: User Group Membership

Report Description:  Report allowing you to view direct, inherited and excluded members of the 

selected user group. Note: This report will not include suggested group membership.

Filtered By : Group Name is <Group Name>

[and]

Membership Type is Meets Criteria or Manually Added 

and Is Direct Member is True

Sorted By : User [Ascending] [Hidden in the report and displayed in the Edit Drawer]

Report Time Zone : Report Runner's Operative Time Zone (Ex: (UTC-05:00) Eastern Time (US & 

Canada))

Date/Time columns marked with this symbol (*) are not converted to the selected Report Time 

Zone.

 

DEFAULT COLUMNS:

1. User

​2. Membership Type

3. Membership Modified By

4. Membership Modified On 

Edit, Print and Download (PDF, CSV and Excel) options

Display N Records (25, 50, 100, 250)

Text displaying "Showing 1 to N of X Records"

Generated On: Date and Time the report is generated based on the Report Time Zone

Admin User will be navigated to the generated User Group Membership Quick Report with the below details  are 

displayed in the User Group Membership  Report:

Report Name: User Group Membership

Report Description:  Report allowing you to view direct, inherited and excluded members of the selected user 

group. Note: This report will not include suggested group membership.

Filtered By : Group Name is <Group Name>

[and]

Membership Type is Meets Criteria or Manually Added 

and Is Direct Member is True

Sorted By : User [Ascending] [Hidden in the report and displayed in the Edit Drawer]

Report Time Zone : Report Runner's Operative Time Zone (Ex: (UTC-05:00) Eastern Time (US & Canada))

Date/Time columns marked with this symbol (*) are not converted to the selected Report Time Zone.

 

DEFAULT COLUMNS:

1. User

​2. Membership Type

3. Membership Modified By

4. Membership Modified On

Edit, Print and Download (PDF, CSV and Excel) options

Display N Records (25, 50, 100, 250)

Text displaying "Showing 1 to N of X Records"

Generated On: Date and Time the report is generated based on the Report Time Zone
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5

6

7

8

9

10

11

4

Verify Records are displayed correctly based on the default Filter criteria and default Sort order.

Verify Users with Membership type "Meets Criteria or Manually Added " are displayed correctly 

for User Group#1:

   1. User#2

   2. User#3

Records will be displayed correctly based on the default Filter criteria and default Sort order.

Users with Membership type "Meets Criteria or Manually Added " will be displayed correctly for User Group#1:

   1. User#2

   2. User#3

5

Verify the Users with Membership type "Manually Excluded " and Suggested Members are not 

displayed for User Group#1:

   1. User#1

   2. User#4

   3. User#5

   4. User#6

Users with Membership type "Manually Excluded " and Suggested Members will not be displayed for User 

Group#1:

   1. User#1

   2. User#4

   3. User#5

   4. User#6

6

Click on any row. Verify Admin User is navigated to User Group General Information screen.

Verify data is displayed correctly in the User Group General Information screen.

Click on Return to Report link. Verify Admin User is navigated back to the User Group 

Membership Quick Report.

Admin User will be navigated to User Group General Information screen.

Data will be displayed correctly in the User Group General Information screen.

Admin User will be navigated back to the User Group Membership Quick Report.

7

Click on Print. Verify Admin User is able to Print the User Group Membership Quick Report and 

data is displayed correctly matching with the UI.

Admin User will be able to Print the User Group Membership Quick Report and data will be displayed correctly 

matching with the UI.

8

Click on Close, and Click on Edit. Verify Default Selected Columns, Filters, Group, and Sort By 

are displayed correctly in respective sections in Edit modal.

Verify the below options are available in all the sections of the Edit Drawer:

   1. Save as New Quick Report

   2. Run Report Without Saving

Verify that filters for the User Group Category are not available in the Filters section of the User 

Group Membership Quick Report.

Default Selected Columns, Filters, Group and Sort By will be displayed correctly in respective sections in Edit 

modal.

Below options will be available in all the sections of Edit Drawer:

   1. Save as New Quick Report

   2. Run Report Without Saving

Filters for User Group Category will not be available in the Filters section of User Group Membership Quick 

Report.

9

Perform any of the below actions in the respective sections, click on "Run Report without 

Saving" button.

   1. Select/De-Select the available columns

   2. Update/Remove Filters by applying additional filters either Standard and/or AFL

   3. Apply Group and Sort By for the selected columns

   4. Update the Report Time Zone

Report will be generated with updated Report Criteria and Records will be displayed correctly based on the 

applied filter criteria.

10

Click on Edit. Verify the below options are available in all the sections of Edit Drawer:

   1. Save as New Quick Report

   2. Run Report Without Saving

Below options will be available in all the sections of Edit Drawer:

   1. Save as New Quick Report

   2. Run Report Without Saving
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13

14

15

16

17

11

Perform any of the below actions in the respective sections, Click on "Save as New Quick 

Report" button. Enter the Report Name and Report Description and click on Save.

   1. Select/De-Select the available columns

   2. Update/Remove Filters by applying additional filters either Standard and/or AFL

   3. Apply Group and Sort By for the selected columns

   4. Update the Report Time Zone

Report will be generated with updated Report Criteria and Records will be displayed correctly based on the 

applied filter criteria.

12

Click on Edit. Verify the options below are available in all the sections of the Edit Drawer:

   1. Save as New Quick Report

   2. Save Report

   3. Run Report Without Saving

Below options will be available in all the sections of Edit Drawer:

   1. Save as New Quick Report

   2. Save Report

   3. Run Report Without Saving

13

Close the Edit Drawer. Navigate back to the Quick Report section. Verify that the Saved New 

Quick Report is displayed in the grid with the correct report name and description. Also, verify 

that the following icons are displayed for the Saved New Quick Report.

1. Run

2. Edit

3. Delete

Saved New Quick Report will be displayed in the grid of the Quick Report section with the correct report name 

and report description and also the following icons.

1. Run

2. Edit

3. Delete

14

Click on the Edit icon for User Group Membership Quick Report; Verify Admin User is navigated 

to User Group Memberships Quick Report and report is not generated.

Admin User will be navigated to User Group Memberships Quick Report and report will not be generated.

15

Click on Quick Reports in the Breadcrumb; Click on the Disable Icon for User Group 

Membership Quick Report and the following Details are displayed in the Disable System Quick 

Report popup:

1. Pop-up tile: Disable System Quick Report

2. Warning icon: ! symbol within Orange triangle shape

3. Report Type: Membership Reports

4. Report Name: User Group Membership

5. Message: Disabling this System Quick Report will disable it for the entire company.(in orange 

color)

6. Cancel button

7. Disable button

8.. X/Close icon

Disable System Quick Report popup will be opened and the following Details will be displayed in the Disable 

System Quick Report popup:

1. Pop-up tile: Disable System Quick Report

2. Warning icon: ! symbol within Orange triangle shape

3. Report Type: Membership Reports

4. Report Name: User Group Membership

5. Message: Disabling this System Quick Report will disable it for the entire company.(in orange color)

6. Cancel button

7. Disable button

8. X/Close icon

16

Click on the Disable button; Change the Status Dropdown to Disabled in the grid of the Quick 

Report section; Verify User Group Membership Quick Report is displayed in the grid.

User Group Membership Quick Report will be disabled and it will be displayed in the disabled Section.
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19

20

21

22

23

24

17

Click on the Enable Icon for User Group Membership Quick Report and the following Details are 

displayed in the Enable System Quick Report popup:

1. Pop-up tile: Enable System Quick Report

2. Warning icon: ! symbol within Orange triangle shape

3. Report Type: Membership Reports

4. Report Name: User Group Membership

5. Message: Enabling this System Quick Report will enable it for the entire company. (in orange 

color)

6. Cancel button

7. Enable button

8. X/Close icon

Enable System Quick Report popup will be opened and the following Details will be displayed in the Enable 

System Quick Report popup:

1. Pop-up tile: Enable System Quick Report

2. Warning icon: ! symbol within Orange triangle shape

3. Report Type: Membership Reports

4. Report Name: User Group Membership

5. Message: Enabling this System Quick Report will enable it for the entire company. (in orange color)

6. Cancel button

7. Enable button

8. X/Close icon

18
Click on the Enable button; Verify User Group Membership Quick Report is Enabled. User Group Membership Quick Report will be Enabled.

19

Click on the Delete Icon for Saved New Quick Report and the following Details are displayed in 

the Delete Quick Report popup:

1. Pop-up tile: Delete Quick Report

2. Warning icon: ! symbol within Orange triangle shape

3. Report Type: Membership Reports

4. Report Name: XXXX(Saved Report Name)

5. Message: Deleting this Quick Report will delete it for the entire company and cannot be 

undone. (in orange color)

6. Cancel button

7. Remove button

8. X/Close icon

Enable System Quick Report popup will be opened and the following Details will be displayed in the Delete 

Quick Report popup:

1. Pop-up tile: Delete Quick Report

2. Warning icon: ! symbol within Orange triangle shape

3. Report Type: Membership Reports

4. Report Name: XXXX(Saved Report Name)

5. Message: Deleting this Quick Report will delete it for the entire company and cannot be undone. (in orange 

color)

6. Cancel button

7. Remove button

8. X/Close icon

20

Click on Remove button; Verify Saved New Quick Report is removed. Saved New Quick Report will be removed.

21

Click on the Reports; Generate the Event Log Report; Apply necessary filters if required to see 

the following events are logged Correctly in the generated Event Log Report for User Group 

Membership Quick Report and Saved New Quick Report ;

1. Disable System Quick Report

2. Enable System Quick Report

3. Delete Quick Report

 

 The following events will be logged Correctly in the generated Event Log Report for User Group Membership 

Quick Report and Saved New Quick Report ;

1. Disable System Quick Report

2. Enable System Quick Report

3. Delete Quick Report

22

Verify Affected Entity is displayed as Base Report name + Name of System Quick Report (Ex: 

Membership Quick Report by User Group - User Group Membership) for Disable System Quick 

Report, Enable System Quick Report and Delete Quick Report events.

Affected Entity will be displayed as Base Report name + Name of System Quick Report (Ex: Membership Quick 

Report by User Group - User Group Membership) for Disable System Quick Report, Enable System Quick Report 

and Delete Quick Report events.

1

 Precondition:

   1. Admin User.

   2. System Default User Group Membership Report for above Admin User.

   3. User Group#1 having Group Type#1 with the Group Membership as below:

      - Excluded: Added User#1 to the Excluded Users section of User Group#1

      - Manually Added: Added User#2 to the Add Users Directly section of User Group#1

      - Meets Criteria: Added User#3 via Edit Group Criteria section of User Group#1

   4. User Group#2 having Group Type#2 with the Group Membership as below:

      - Manually Added: Added User#1 to the Add Users Directly section of User Group#2

      - Meets Criteria: Added User#2 via Edit Group Criteria section of User Group#2

      - Excluded: Added User#3 to the Excluded Users section of User Group#2

   5. User Group#1 is added as Parent Group to User Group#2.
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25

26

27

28

29

30

2

Login as Admin User; navigate to Admin Home.

Click on Reports tab. Click on User Group membership report.

User will be navigated to the User Group membership report page.

3

Click on Run Report button; Verify records are displayed correctly based on the default Filter 

criteria and Sort order in the generated report.

Records will be displayed correctly based on the default Filter criteria and Sort order in the generated report.

4

Click on Edit, select below columns:

          o Membership Modified By

          o Membership Modified By First Name

          o Membership Modified By Last Name

          o Membership Modified By User ID

          o Membership Modified On

Click on Filters, remove existing saved filters, select "Is Direct Member" as filter type, select any 

of the below operator(s), select any value in the value drop down; click on "+Set Filter"; Apply 

additional filter for the User Group(s) mentioned in the Precondition; click on "Set as My 

Default" button.

Operator(s):

   1. is

Value dropdown:

   1. True

   2. False

Below columns will be selected:

          o Membership Modified By

          o Membership Modified By First Name

          o Membership Modified By Last Name

          o Membership Modified By User ID

          o Membership Modified On

Filter(s) with value will be added to the workbench under correct Category.

Records will be displayed as per the applied filter criteria in the generated report.

5

Click on Edit, click on Filters, remove existing saved filters, select "Membership Modified By" as 

filter type, select the 'is' operator, select any value in the value drop down; click on "+Set 

Filter"; Apply additional filter for the User Group(s) mentioned in the Precondition; click on "Set 

as My Default" button.

Filter(s) with value will be added to the workbench under correct Category.

Records will be displayed as per the applied filter criteria in the generated report.

6

Click on Edit, click on Filters, remove existing saved filters, select "Membership Modified By 

First Name" as filter type, select any of the below operator(s), select any value in the value drop 

down; click on "+Set Filter"; Apply additional filter for the User Group(s) mentioned in the 

Precondition; click on "Set as My Default" button.

Operator(s):

   1. is

   2. contains

Filter(s) with value will be added to the workbench under correct Category.

Records will be displayed as per the applied filter criteria in the generated report.

7

Click on Edit, click on Filters, remove existing saved filters, select "Membership Modified By Last 

Name" as filter type, select any of the below operator(s), select any value in the value drop 

down; click on "+Set Filter"; Apply additional filter for the User Group(s) mentioned in the 

Precondition; click on "Set as My Default" button.

Operator(s):

   1. is

   2. contains

Filter(s) with value will be added to the workbench under correct Category.

Records will be displayed as per the applied filter criteria in the generated report.
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32

33

34

35

8

Click on Edit, click on Filters, remove existing saved filters, select "Membership Modified By 

User ID" as filter type, select the 'is' operator, select any value in the value drop down; click on 

"+Set Filter"; Apply additional filter for the User Group(s) mentioned in the Precondition; click 

on "Set as My Default" button.

Filter(s) with value will be added to the workbench under correct Category.

Records will be displayed as per the applied filter criteria in the generated report.

9

Click on Edit, click on Filters, remove existing saved filters, select "Membership Modified On" as 

filter type, select any of the below operator(s), select any date value; click on "+Set Filter" ; 

Apply additional filter for the User Group(s) mentioned in the Precondition; click on "Set as My 

Default" button.

Operator(s):

1. is

2. greater than

3. greater than or equal to

4. less than

5. less than or equal to

6. is between

7. is within Last N Days

8. is within Last N Weeks

9. is within Last N Months

10. is within Last N Quarters

11. is within Last N Years

Filter(s) with value will be added to the workbench under correct Category.

Records will be displayed as per the applied filter criteria in the generated report.

10

Click on Edit, click on Filters, remove existing saved filters, select "Membership Source" as filter 

type, select any of the below operator(s), select any value in the value drop down; click on 

"+Set Filter"; Apply additional filter for the User Group(s) mentioned in the Precondition; click 

on "Set as My Default" button.

Operator(s):

   1. is

   2. contains

   3. begins with

   4. ends with

Filter(s) with value will be added to the workbench under correct Category.

Records will be displayed as per the applied filter criteria in the generated report.

11

Click on Edit, click on Filters, remove existing saved filters, select "Membership Type" as filter 

type, select any of the below operator(s), select any value in the value drop down; click on 

"+Set Filter"; Apply additional filter for the User Group(s) mentioned in the Precondition; click 

on "Set as My Default" button.

Operator(s):

   1. is

Value dropdown:

   1. Excluded

   2. Manually Added

   3. Meets Criteria

Filter(s) with value will be added to the workbench under correct Category.

Records will be displayed as per the applied filter criteria in the generated report.

12

Click on any row in the generated User Group Membership Report; Verify Admin User will be 

navigated to the Group Information page.

Admin User will be navigated to the Group Information page.
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36

37

38

39

40

41

13

Click on Membership History from left Navigation under 'History and Reports'; 

Verify the below details displayed in the Group Membership History is matching with the Group 

Membership Report:

1. Action (Group Membership History) matches with MEMBERSHIP TYPE (Group Membership 

Report)

2. Modified By (Group Membership History) matches with MEMBERSHIP MODIFIED BY (Group 

Membership Report)

3. Modified On (Group Membership History) matches with MEMBERSHIP MODIFIED ON (Group 

Membership Report)

Below details will be displayed in the Group Membership History is matching with the Group Membership 

Report:

1. Action (Group Membership History) matches with MEMBERSHIP TYPE (Group Membership Report)

2. Modified By (Group Membership History) matches with MEMBERSHIP MODIFIED BY (Group Membership 

Report)

3. Modified On (Group Membership History) matches with MEMBERSHIP MODIFIED ON (Group Membership 

Report)

14

Click on Return to Report button; Verify Admin User will be navigated to the User Group 

Membership Report

Admin User will be navigated to the User Group Membership Report.

1

  Precondition

   1. Admin User#1 in top level organization

   2. Admin User#2 in Middle level organization level.

   3. Security Role with 'View users" security bit selected and "View User Groups' security bits 

not selected in top organization level and Test User#1 assigned with this security role.

   4. User Group#1 homed at Top Level organization having Group Membership with Users 

added Directly, Excluded and Meets Criteria

   5. User Group#2 homed at Middle Level organization having Group Membership with Users 

added Directly, Excluded and Meets Criteria

   6. User Group#3 homed at Low Level organization having Group Membership with Users 

added Directly, Excluded and Meets Criteria

   7. User Group Membership Report with the below additional columns selected by Admin 

User#1.

          o Membership Modified By

          o Membership Modified By First Name

          o Membership Modified By Last Name

          o Membership Modified By User ID

          o Membership Modified On

   8. Saved User Group Membership Report#1 shared by Admin User#1 to Admin User#2, Test 

User#1 with 'Sharer's (My) Security' security option selected

   9. Saved User Group Membership Report#2 shared by Admin User#1 to Admin User#2, Test 

User#1 with 'Recipient's Security' security option selected

2

Login in as Admin User#2 as mentioned in the precondition. Click on "Reports"' and click on 

'Shared Reports' link.

Shared User Group Membership Reports will be displayed under 'Shared Reports' in Reports tab of Admin 

User#2.

3

Verify Saved User Group Membership Report#1 is displayed with "Sharer's (FirstName's) data 

security permission applied" security displayed.

Note: The "FirstName's" displayed in the "Sharer's (FirstName's) data security permission 

applied", displays the FirstName's with a "'s" of the user who shared the report

Saved User Group Membership Report#1 will be displayed with "Sharer's (FirstName's) data security permission 

applied" security displayed 

4

Verify Saved User Group Membership Report#2 is displayed with "My (FirstName's) data 

security permission applied" security displayed.

Note: The "FirstName's" displayed in the "My (FirstName's) data security permission applied", 

displays the FirstName's with a "'s" of the logged user.

Saved User Group Membership Report#2 will be displayed with "My (FirstName's) data security permission 

applied" security displayed.
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42

43

44

45

46

47

48

49

5

Click on Go to Report Button of Saved User Group Membership Report#1, Click on 'Run Report' 

button Verify below User Groups are displayed in the shared report:

   1. User Group#1

   2. User Group#2

   3. User Group#3

Below User Groups will be displayed in the shared report:

   1. User Group#1

   2. User Group#2

   3. User Group#3

6

Click on any row in the report; Verify the links are not enabled and Admin User#2 will not be 

able to access the User Group Information.

Links will not be enabled, and Admin User#2 will not be able to access the User Group Information.

7

Click on Knowledge Center from user profile;  Click on Reports; Click on Shared Reports and 

click on Go to Report Button of Saved User Group Membership Report#2, click on 'Run the 

Report'. Verify below User Groups are displayed in the shared report.

   1. User Group#2

   2. User Group#3

Verify below User Group is not displayed in the shared report.

   1. User Group#1

Below User Groups will be displayed in the shared report.

   1. User Group#2

   2. User Group#3

Below User Group will not be displayed in the shared report.

   1. User Group#1

8

Sign Out and login in as Test User#1 as mentioned in the precondition. Click on 'Reports' tab 

and click on 'Shared Reports' link.

Shared User Group Membership Reports will be displayed under 'Shared Reports' in Reports tab of Test User#1.

9

Verify Saved User Group Membership Report#1 is displayed with "Sharer's (FirstName's) data 

security permission applied" security displayed.

Note: The "FirstName's" displayed in the "Sharer's (FirstName's) data security permission 

applied", displays the FirstName's with a "'s" of the user who shared the report

Saved User Group Membership Report#1 will be displayed with "Sharer's (FirstName's) data security permission 

applied" security displayed 

10

Verify Saved User Group Membership Report#2 is displayed with "My (FirstName's) data 

security permission applied" security displayed.

Note: The "FirstName's" displayed in the "My (FirstName's) data security permission applied", 

displays the FirstName's with a "'s" of the logged user.

Saved User Group Membership Report#2 will be displayed with "My (FirstName's) data security permission 

applied" security displayed.

11

Click on Go to Report Button of Saved User Group Membership Report#1, Click on 'Run Report' 

button Verify below User Groups are displayed in the shared report.

   1. User Group#1

   2. User Group#2

   3. User Group#3

Below User Groups will be displayed in the shared report.

   1. User Group#1

   2. User Group#2

   3. User Group#3

12

Click on Knowledge Center from user profile, Click on Reports tab; Click on Shared Reports and 

Click on Go to Report Button of Saved User Group Membership Report#2, Click on 'Run Report' 

button. Verify no records are displayed in it.

No records will be displayed in the shared report.
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50

51

52

53

54

55

56

57

58

59

1

Precondition:

1. Admin User with Preferred language set to English.

2. Scheduled Report - No Records found email template set to Standard format.

2

Login as Admin user. Navigate to Administrative View> Site Configuration and click on Manage 

E-mail Translations.

Admin user will be able to login and navigate to Manage E-mail translations page

3

Verify for new template 'Scheduled Report - No Records found' is available in the Manage E-

mail Translations page

New template 'Scheduled Report - No Records found' will be available in the Manage E-mail Translations page

4

Verify that the below columns are displayed with below data for the new template in the 

Manage E-mail Translations page.

1. Template Name: Scheduled Report - No Records found

2.  Description: E-mail that the scheduled report recipient receives when no records found.

3. Status: Standard

4. Organization: Top Level Organization Name

5. Last Modified By: "BLANK"

6. Last Modified Date: "BLANK"

Below columns will be displayed with below data for the new template in the Manage E-mail Translations page.

1. Template Name: Scheduled Report - No Records found

2.  Description: E-mail that the scheduled report recipient receives when no records found.

3. Status: Standard

4. Organization: Top Level Organization Name

5. Last Modified By: "BLANK"

6. Last Modified Date: "BLANK"

5

Click on the 'Scheduled Report - No Records found' template and verify Admin User is navigated 

to the Scheduled Report - No Records found template screen.

Admin User will be navigated to the Scheduled Report - No Records found template screen.

6

Verify 'Scheduled Report - No Records found' template by default displays the below:

i. Subject: ComplianceWire Scheduled Report - No Records found

ii. Header: Hello |FIRSTNAME|,

iii. Body: Your scheduled report has Resulted in no records found.

iv. Footer: This e-mail has been sent to |USERNAME|<BR>|LASTNAME|, |FIRSTNAME| 

|USERNAME| - |COMPANYNAME| (|COMPANYCODE|)<BR>This e-mail has been sent from an 

automated service.

v. Footer Link: <a 

href="http://www.ComplianceWire.com/Partners/|PARENTCOMPANY|">ComplianceWire 

Login</a>

Scheduled Report - No Records found' template by default will display the below:

i. Subject: ComplianceWire Scheduled Report - No Records found

ii. Header: Hello |FIRSTNAME|,

iii. Body: Your scheduled report has Resulted in no records found.

iv. Footer: This e-mail has been sent to |USERNAME|<BR>|LASTNAME|, |FIRSTNAME| |USERNAME| - 

|COMPANYNAME| (|COMPANYCODE|)<BR>This e-mail has been sent from an automated service.

v. Footer Link: <a href="http://www.ComplianceWire.com/Partners/|PARENTCOMPANY|">ComplianceWire 

Login</a>

7

Click on Preview Button and verify, 'Preview: Scheduled Report - No Records found' pop-up 

window is displayed with below details.

1. Subject

2. Header

3. Body

4. Footer

5. Footer Link

'Preview: Scheduled Report - No Records found' pop-up window will be displayed with below details.

1. Subject

2. Header

3. Body

4. Footer

5. Footer Link

8

Verify Subject of the Scheduled Report - No Records found is displayed as ' ComplianceWire 

Scheduled Report - No Records found'.

Subject of the Scheduled Report - No Records found will be displayed as 'ComplianceWire Scheduled Report - No 

Records found'

9

Verify Header section content is displayed as 'Hello |FIRSTNAME|,' of the logged in User. Header section will be displayed as 'Hello |FIRSTNAME|,' of the logged in User.

10

Verify, Body section content is displayed as 'Your scheduled report has Resulted in no records 

found.'.

Body section content will be displayed as 'Your scheduled report has Resulted in no records found.'.

Site Configuration_Manage E-

mail Translations_Scheduled 

Report - No Records 

found_Standard E-mail 

Template
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11
Verify Grid section is displayed as ''[ Grid Displayed Here ]'. Grid section will be displayed as '[ Grid Displayed Here ]'.

12

Verify Footer section content is displayed as below:

This e-mail has been sent to |USERNAME|<BR> |LASTNAME|, |FIRSTNAME| |USERNAME| - 

|COMPANYNAME| (|COMPANYCODE|) <BR>

This e-mail has been sent from an automated service.

Footer section content will be displayed as below:

This e-mail has been sent to |USERNAME|<BR> |LASTNAME|, |FIRSTNAME| |USERNAME| - |COMPANYNAME| 

(|COMPANYCODE|) <BR>

This e-mail has been sent from an automated service.

13
Verify 'ComplianceWire Login' link is displayed. 'ComplianceWire Login' link will be displayed.

14

Click on 'ComplianceWire Login' link and verify User is redirected to 'ComplianceWire Login' 

Page.

Admin User will be redirected to 'ComplianceWire Login' Page.

1

Precondition:

1. Admin User with Preferred language set to English.

2. Scheduled Report - No Records found email template set to Standard format.

2

Login as Admin user. Navigate to Administrative > Site Configuration and click on Manage E-

mail Translations.

Admin user will be able to login and navigate to Manage E-mail translations page

3

Verify for new template "Scheduled Report - No Records found" is available in the Manage E-

mail Translations page

New template "Scheduled Report - No Records found" will be available in the Manage E-mail Translations page

4

Verify that the below columns are displayed with the below data for the new template in the 

Manage E-mail Translations page.

1. Template Name: Scheduled Report - No Records found

2.  Description: E-mail that the scheduled report recipient receives when no records found.

3. Status: Standard

4. Organization: Top Level Organization Name

5. Last Modified By: "BLANK"

6. Last Modified Date: "BLANK"

Below columns will be displayed with below data for the new template in the Manage E-mail Translations page.

1. Template Name: Scheduled Report - No Records found

2.  Description: E-mail that the scheduled report recipient receives when no records found.

3. Status: Standard

4. Organization: Top Level Organization Name

5. Last Modified By: "BLANK"

6. Last Modified Date: "BLANK"

5

Click on the 'Scheduled Report - No Records found' template and verify Admin User is navigated 

to the Scheduled Report - No Records found template screen.

Admin User will be navigated to the Scheduled Report - No Records found template screen.

6

Customize few fields. Verify the success message is displayed on customizing each field. Close 

the success message box and verify the updated field text gets saved.

Success message will be displayed, and the Selected fields of the Template will be customized in English 

Language.

7
Verify 'Edit' link is now displayed for the fields just customized. Edit' link will now be displayed for the fields just customized.

8

Click on 'Edit' link next to a customized field and click on 'Reset to Standard'. Click on 'Continue' 

and click 'OK' and verify the default CW text is reset for the selected field.

The default CW text will be reset for the selected field.

9
Customize all the fields of the 'Scheduled Report - No Records found' template. All fields of the 'Scheduled Report - No Records found' template will be customized.

10

Click on 'Preview' and verify the updated text is displayed correctly for all the changes made in 

the Preview window.

Preview window will display the updated text correctly for all the changes made.

11
Click on "Manage E-mail Translations" link in the breadcrumb. Admin user will be navigated back to the Manage E-mail Translations screen.

Site Configuration_Manage E-

mail Translations_Scheduled 

Report - No Records 

found_Standard E-mail 

Template

Site Configuration_Manage E-

mail Translations_Scheduled 

Report - No Records 

found_Customized E-mail 

Template
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12

Verify that the below columns are displayed with the below data for the new template in the 

Manage E-mail Translations page.

1. Template Name: Scheduled Report - No Records found

2.  Description: E-mail that the scheduled report recipient receives when no records found.

3. Status : Customized

4. Organization: Top-Level Organization

5. Last Modified By: "User who modified the field content"

6. Last Modified Date: "The Date on which it was recently modified."

The below columns will be displayed with the below data for the new template in the Manage E-mail 

Translations page.

1. Template Name: Scheduled Report - No Records found

2.  Description: E-mail that the scheduled report recipient receives when no records found.

3. Status : Customized

4. Organization: Top-Level Organization

5. Last Modified By: "User who modified the field content"

6. Last Modified Date: "The Date on which it was recently modified."

1

Preconditions:

1. Company Preference "Link Expiry for Scheduled Report In Days." set as X days.

2. Company Preference "Allow sending schedule reports to external recipient" is turned ON.

3. Company Preference " Allow reports to be dropped on FTP/SFTP" is turned ON.

4. Company Preference " FTP Subfolder Name" is set to EDU/EDUQA.

5. Admin User#1 with a valid email address

6. Admin User#2 with a valid email address and Preferred Language set to other than English.

7. Customized Email Template for "Scheduled Report - No Records found" with Status is set to 

Customized.

8. Scheduled Saved Report#1 that results in No Records (Curriculum Qualification Report) with 

Delivery Type selected as "Email with an Attachment" for any Report for Admin User#1 and 

preferred file type.

9. Scheduled Saved Report#2 that results in No Records (Any tabular report) with Delivery Type 

selected as "File Drop to SFTP/FTP" for any Report for Admin User#1 and preferred file type.

10. Scheduled Saved Report#3 that results in No Records with Delivery Type selected as "Email 

with Link", "Email with an Attachment " and "File Drop to SFTP/FTP" for any Report for Admin 

User#2 and preferred file type. 

2

Login as Admin User#1 on the date and time the report schedule as mentioned in the 

precondition; Navigate to My Notifications page; Apply filter for Email Type "Scheduled Report - 

No Records found"; Click on the eMail for the Scheduled Report#1 and verify email pop-up 

window is displayed with the customized details.

1. Email type in the header: Scheduled Report - No Records found

2. Sent On

3. Subject : ComplianceWire Scheduled Report - No Records found

4. Email Body: 

Hello <Firstname>,

Your scheduled report has run and no records found.

Report Name<Report Name>Base Report Name<Report Type>Report Description<Description 

of the Saved Report>

This e-mail has been sent to <Username>

<Lastname>, <Firstname><Username>- Organization Name (Company Code)

This e-mail has been sent from an automated service.

ComplianceWire Login

6. x CLOSE button

7. X icon on the top.

An email pop-up window will be displayed with all customized details correctly.

Site Configuration_Manage E-

mail Translations_Scheduled 

Report - No Records 

found_Customized E-mail 

Template

Email_Scheduled Report - No 

Records found_Customised
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3

Verify that report with the selected file type is not attached to the email. Also Scheduled Report 

- No Records found Email for the scheduled saved report will not display the row "Link Expiry" 

and "X day(s)" in the tabular grid.

Report with the selected file type will not be attached to the email. 

Also Email for the scheduled saved report will not display the row "Link Expiry" and "X day(s)" in the tabular 

grid.

4

Close the eMail; Search the eMail for the Scheduled Saved Report#2 and verify that eMail is not 

listed and Report is dropped for the Scheduled Saved Report having Delivery Type selected as 

"File Drop to FTP".

An email will not be listed for the Scheduled Saved Report#2 having the Delivery Type selected as "File Drop to 

FTP".

Report will be dropped at FTP and/or SFTP site.

5

Signout and Log in as Admin User#2 on the date and time the report schedule is mentioned in 

the precondition; navigate to the My Notifications page; apply the filter for Email Type 

"Scheduled Report—No Records found"; click on the email for Scheduled Report#3 and verify 

that an email pop-up window is displayed with the below details based on the User's Preferred 

Language.

1. Email type in the header: Scheduled Report - No Records found

2. Sent On

3. Subject: ComplianceWire Scheduled Report - No Records found

4. Email Body  Hello <Firstname>,

Your scheduled report has run and no records found.

Report Name <Report Name>Base Report Name<Report Type>Report Description <Description 

of the Saved Report>

This e-mail has been sent to <Username>

<Lastname>, <Firstname><Username>- Organization Name (Company Code)

This e-mail has been sent from an automated service.

ComplianceWire Login

6. X Close button

7. X icon on the top.

An email pop-up window will be displayed with all customized details correctly based on the User's Preferred 

Language.

6

Verify Report is dropped at FTP and/or SFTP site. Report will be dropped at FTP and/or SFTP site.

1

Precondition:

1. Admin User

2

Login as Admin User, Click on User Profile, Click on Administrative View, click on Reports > Base 

Reports, Select any of the report.

Selected report page will be displayed.

3

Click on "Queue Report" button, the report will be Queued and displayed as "Your report has 

been queued and will be available from the Reports tab on the Knowledge Center"

The report will be queued.

4

Click on the link displayed as "Your report has been queued and will be available from the 

Reports tab on the Knowledge Center".

Verify that Admin user navigates to Offline Queued Report Requests

Admin User will be navigated to Offline Queued Report Requests

5

Verify that in Offline Queued Reports the report is listed and showing status as "Queued'. The Reports will be displayed under Offline Report Requests as status "Queued".

283585

Email_Scheduled Report - No 

Records found_Customised

284014
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6

Verify that the Offline Queued Report Requests grid displays below details:

1. Report Name

2. Base Report Name

3. Requested On

4. Request Status

Offline Queued Report Requests will be displayed with below details:

1. Report Name

2. Base Report Name

3. Requested On

4. Request Status

7

Sign Out and Login as Admin User, Click on Reports > Offline Queued Report Requests.

Verify that Offline Queued Report Requests grid displays below details:

1. Report Name

2. Base Report Name

3. Requested On

4. Request Status

5. "Download" option shows next to request status "Completed"

Offline Queued Report Requests will be displayed with below details for Admin User:

1. Report Name

2. Base Report Name

3. Requested On

4. Request Status

5. "Download" option will display next to request status "Completed"

8

Click on "Download", verify the report is downloaded Admin User will be able to download the report and view the details correctly.

1

Precondition:

1. Saved Report#1

2. Saved Report#2

3. User#1

4. User Group#1 with Learner

5. Share Saved Report#1 to User#1 with Security Setting as Sharer's (My) Security

6. Share Saved Report#2 to User Group#1 with Security Setting as Recipient's Security

2
Login as User#1, Navigate to Reports, Click on Shared Reports My Reports > Shared Report will be displayed.

3

Verify that Shared Reports grid displays below details:

1. Report Name

2. Base Report Name

3. Shared By

4. Security

5. Go to Report button

Verify that Security for Shared Report#1 is displayed as "Sharer's (User's First name) data 

security permission applied"

Shared Reports will be displayed with below details:

1. Report Name

2. Base Report Name

3. Shared By

4. Security

5. Go to Report button

Security will be displayed as "Sharer's (User's First name) data security permission applied"

4

Click on Go to Report. 

Verify that User#1 is able to run the report and view the data. 

User#1 will be able to Go to Report.

User#1 will be able to run the report and view the data.

283585

283588

Knowledge 

Center_Reports_Offline 

Queued Report Requests
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5

Sign Out and Login as Learner, Navigate to Reports, Click on Shared Reports

Verify that Shared Reports grid displays below details:

1. Report Name

2. Base Report Name

3. Shared By

4. Security

5. Go to Report button

Verify that Security for Shared Report#2 is displayed as "My (User's First name) data security 

permission applied" 

Shared Reports will be displayed with below details:

1. Report Name

2. Base Report Name

3. Shared By

4. Security

5. Go to Report button

Security will be displayed as "My (User's First name) data security permission applied" 

6

Click on Go to Report. 

Verify that the Learner is able to run the report and no records are displayed.

Learner will be able to Go to Report.

Learner will be able to run the report and no records will be displayed.

283588 Knowledge 

Center_Reports_Shared 

Reports
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